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Contents at a glance
This user’s manual contains the information you need to efficiently use
ASUS MyPal A600 Pocket PC.

• Chapter 1 - Get started!
This chapter introduces the ASUS MyPal A600 Pocket PC, how to set
and power it up, and basic screens that will help you get to know its
many features.

• Chapter 2 - Learn the basics
This chapter will teach you the basic functions in MyPal A600. You will
learn how to enter, find, and organize information, customize the
device, and use the bundled ASUS utilities.

• Chapter 3 - Microsoft® ActiveSync®

This chapter tells you how to use the Microsoft ActiveSync to
synchronize your device with your desktop computer.

• Chapter 4 - Microsoft® Pocket Outlook
This chapter details the procedures for the Microsoft Pocket Outlook
Calendar, Contacts, Tasks, Notes, and Inbox.

• Chapter 5 - Companion programs
This chapter includes information on Pocket Word, Pocket Excel, MSN
Messenger, Windows Media Player for Pocket PC, and Microsoft
Reader.

• Chapter 6 - Pocket Internet Explorer
This chapter gives information and procedures on using Pocket
Internet Explorer, Mobile Favorites folder, and AvantGo interactive
service.

• Chapter 7 - Get connected
This chapter provides the procedures for connecting to the Internet and
for transferring data using infrared.

• Chapter 8 - Appendix
This part includes the safety notices and regulations.
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MyPal A600 specifications

MyPal A600 package
Your package includes several accessories for the Pocket PC. After
unpacking, check the items against the list below and make sure that they
are in good condition. If any item is missing or damaged, contact your
dealer or retailer immediately.

Deluxe Model Standard Model

• ASUS MyPal A600 • ASUS MyPal A600

• ASUS MyPal A600 USB cradle • Stylus (1 pc)

• ASUS MyPal A600 AC adapter • ASUS MyPal A600 AC adapter
(5V/3A with regional conversion plug) (5V/3A with regional conversion plug)

• Stylus (2 pcs) • USB sync cable (40-pin)

• Mini-USB sync cable (for the cradle) • Protective case

• USB sync cable (40-pin) • Microsoft Companion CD

• Protective case • ASUS MyPal A600 User’s Manual

• LCD cleaning cloth • Quick Start Guide

• Microsoft Companion CD • Warranty card

• Bonus CD (add’l Pocket PC software)

• ASUS MyPal A600 User’s Manual

• Quick Start Guide

• Warranty card

Processor

Software

Memory

Display

Card slots

Infrared

Audio

Size

Weight

Intel PXA250 400 MHz

Microsoft Pocket PC 2002

64MB SDRAM, 32MB Flash ROM

3.5-inch, 240 x 320 pixels
65,536 colors, TFT LCD

SD/MMC slot

FIR/SIR

Stereo headphone jack
Built-in microphone
Built-in speaker

75 mm x 125 mm x 12.8 mm

138g
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Introducing MyPal
The ASUS® MyPal A600 is truly a good companion wherever you go.
Powered by a 400MHz Intel® PXA250 processor, equipped with 64MB
SDRAM and 32MB Flash ROM, and bundled with the latest Microsoft
Pocket PC 2002 plus a host of useful utilities, you have everything you
need in your pocket!

Front features

• LCD touch screen - allows you to enter, read, send, receive, or edit data
by tapping on it. The screen lumination is increased or decreased by
changing the backlight settings.

• ASUS Settings, Calendar, Tasks, and Contacts buttons - allow you
quick access to commonly used programs.

• Navigation button - functions like the four arrow keys on a keyboard
when you press its corners. This button allows you to move from one
program icon to another.

• Speaker - allows you to hear alarms and other sound outputs from the
device.

LCD touch screen

Navigation button
Tasks button
Contacts button

ASUS Settings button
Calendar button

Speaker
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Side features

• Charging status LED - lights up orange when the battery is charging;
lights up green when the battery is fully charged.

• System indicator LED - indicates the system status.

• Power/Front light button - turns the device power on or off if you press
the button quickly. Pressing and holding the button for a few seconds
turns the front light on or off. Turning off the front light saves battery
power.

NOTE Press this button and the Tasks button simultaneously if you
wish to launch the Align Screen function.

• Scroll dial - allows you to scroll through a menu and open an
application.

• Record/Notes button - allows you to record sounds and save them as
files if you press and hold the button. Pressing this button quickly will
launch the Notes program.

• Software reset button - allows you to perform a soft reset in case of
device malfunctions, or when an application hangs.

Charging status LED
System indicator LED
Power/Front light button

Scroll dial

Record/Notes button

Software reset button
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Top features

Bottom features

DC IN

• Stylus - used for tapping or writing on the LCD touch screen. Slide out
the stylus from its compartment. Refer to the descirption of the stylus on
the next page.

• IR port - allows you to copy or send data to another device with an IR
port.

• SD/MMC slot - accommodates a Secure Digital (SD) card or a
Multimedia Memory Card (MMC card).

• Microphone - magnifies your sound recording.

• Headphone jack - connects a headphone.

Stylus IR port SD/MMC slot Microphone Headphone jack

Cradle connector /
Sync cable connector

Power connector

• Cradle connector / Sync cable connector - connects to the 40-pin
female connector on the cradle. If you are not using the cradle, connect
the 40-pin USB sync cable directly to this connector to synchronize your
device with your computer.

• Power connector - connects the AC adapter cable. Use this connector if
you wish to use AC power without the cradle.
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Cradle features
Your standard package includes the cradle for MyPal. The cradle has
three connectors.

• Device connector - holds the device in place. This is a 40-pin connector
that matches the connector on the bottom of the device.

• Mini-USB connector - synchronizes the device with your PC using the
bundled USB PC cable. This connector is located at the back side of the
cradle.

• Power connector - connects the bundled AC adapter. This connector is
located at the back side of the cradle.

Device connector Mini-USB connector

Power connector

The stylus
The stylus functions on a Pocket PC the same way a mouse functions on
a standard PC. Use the stylus to tap or drag on the LCD touch screen to
open programs or execute commands.

• Tap. Touch the screen once with the stylus to open programs and select
options.

• Drag. Hold the stylus on the screen and drag across the screen to select
text and images. Drag in a list to select multiple items.

• Tap and hold. Tap and hold the stylus on an item to see a list of actions
available for that item. On the displayed pop-up menu, tap the action that
you want to perform.

Stylus
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Setting up MyPal

Placing on the cradle

Connecting the AC adapter
• Connect the AC adapter cable to the connector at the back of the cradle.

Connect the power plug to a grounded wall socket. See Figure 1.

• If you are not using the cradle, connect the AC adapter cable directly to
the power connector at the bottom of the device. Connect the power plug
to a grounded wall socket. See Figure 2.

Position the device on the cradle as shown
on the right. Match the connectors and
carefully insert the device until it fits in place.

The illustration on the left shows MyPal
properly installed on the cradle.

Figure 1 Figure 2
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Charging the battery
Your device includes a rechargeable
Lithium Polymer battery. You must charge
the battery before using the device the first
time. The battery starts charging as soon
as you connect the AC adapter to a power
source. Use the AC adapter to plug your
device to a power source whenever
possible, especially when you are using a
modem or other peripherals, using the
device backlight, connecting to a PC, or
letting notification light flash for extended
time periods.

To display the power status, tap  ,
Settings, System tab, and the Power icon.

Activating MyPal
It is important that you properly calibrate and activate your device before
using it. This process ensures accurate positioning when entering text and
selecting menus.

Follow these steps to calibrate and activate MyPal.

1. Press the power button.

2. Use the stylus to tap the LCD touch screen to start the calibration and
activation.

3. At the prompt to align the screen, tap the center of the cross whenever
the travelling cross stops on the screen. You may have to do this step
several times to properly calibrate.

4. When done with the screen calibration, follow the screen instructions to
complete the activation.

• at the “Stylus” screen, tap Next to continue.

• at the “Pop-up menus” screens, perform the indicated operations.

• at the “Congratulations” screen, tap Next to continue.

• at the “Location” screen, select your time zone and tap Next to
continue.

• at the “Completion” screen, tap the screen to continue.

5. When the Today screen appears, MyPal is ready to use. Proceed to
the next section for information on the basic screens on your device.
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Basic screens on MyPal

Today screen
Normally, the Today screen appears when you turn on your device for the
first time each day.

NOTE When the device is already on and the screen displays
another program, you can display the Today screen by

tapping the  icon. Then from the Navigation bar, tap Today.

As shown in the sample below, the Today screen lets you see at a glance
the summary of the important information for the day.

From the Today screen, tap any of the listed items with the stylus to
display the details. See “Chapter 2: Learn the basics” to learn how to
modify the current tasks or activities, or to add new items or information.

On the bottom of the Today screen is the Command bar. Tap New from the
Command bar to create a new appointment, contact, note, task, e-mail, or
an Excel or Word document.
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Navigation Bar screen

On top of the Today screen is the Navigation bar. This bar includes the 
icon, speaker icon, current time, and any other active program.

Tap the  icon on the Navigation bar to display a drop down list of the
programs installed in your device.

Icon Program Description

ActiveSync Synchronize information between your
device and your desktop computer.

Calendar Keep track of your appointments and create
meeting requests.

Contacts Keep track of your friends and colleagues.

Inbox Send and receive e-mail messages.

Internet Explorer Browse Web and WAP sites, and download
new programs and files from the Internet.

Notes Create handwritten or typed notes, drawings,
and recordings.

Tasks Keep track of your tasks.

Programs Tap to see additional programs installed in
your device.

Settings Tap to see items that you can customize or
adjust to your preference.

Find Tap to find data in your device.

Help Tap to see the Help contents.
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Pop-up menus
With the pop-up menus, you can easily choose an action for an item. For
example, you can use the pop-up menu in Tasks to delete, copy, or beam
a task. The actions in the pop-up menus vary from program to program. To
access a pop-up menu, tap and hold the stylus on the item that you wish
to perform action on. When the menu appears, lift the stylus, and tap the
action that you want to execute. To close the pop-up menu without
performing an action, tap anywhere outside the menu.

Notifications
Your device can remind you of things you have to do in several ways. For
example, if you have set up an appointment in Calendar, a task with a due
date, or an alarm in Clock, you will be notified in any of the following ways.

• A message box appears on the screen

• A sound is played (you can select the type of sound)

• A light flashes on the device

To choose the reminder types and sounds, tap  icon then tap Settings.
In the Settings screen, tap Sounds and Notifications.

Proceed to Chapter 2 to learn the basics, and to the succeeding chapters
to learn the many other things you can do on your device and the things it
can do for you!
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Entering information
You can enter information in your device.

• Use the input panel to enter text using the soft keyboard or the Letter
recorgnizer

• Write directly on the screen with the stylus

• Draw pictures on the screen

• Speak into  the device microphone to record a message

• Use the Microsoft ActiveSync to synchronize or copy information from
your desktop computer to your device

Entering text using the Input Panel
Use the Input Panel to enter information in any program on your device.
you can either type using the soft keyboard or write using the Letter
Recognizer, Block Recognizer, or Transcriber. In either case, the
characters appear as typed text on the screen.

To show or hide the input pane, tap the Input Panel button. Tap the arrow
next to the Input Panel button to see your options.

To type with the soft keyboard:

1. Tap the arrow next to the Input Panel button, then tap Keyboard.

NOTE To demonstrate, open Notes.

2. Tap the keys with the stylus to enter information.
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When you use the Input Panel and the soft keyboard, your device
anticipates the word you are typing and displays it above the Input Panel.
When you tap the displayed word, it is inserted into your text at the
insertion point. The more your use your device, the more words it learns to
anticipate.

NOTE To change options on word completion feature:

1. Tap   .
2. Tap Settings.
3. Tap Personal tab.
4. Tap Input.
5. Tap Word Completion tab.
6. Make your desired changes.

To use Letter Recognizer:

With the Letter Recognizer, you can write letters on the screen with the
stylus as you would on paper.

1. Tap the arrow next to the Input Panel button, then tap Letter
Recognizer.

2. Write a letter in the box.

When you write a letter, it is converted to a typed text that appears on
the screen. For instructions and demonstation on using the Letter
Recognizer, tap the question mark next to the writing area.
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To use Block Recognizer:

With the Block Recognizer, you can input character strokes that are similar
to those use on other devices.

1. Tap the arrow next to the Input Panel button, then tap Block
Recognizer.

2. Write a letter in the box.

When you write a letter, it is converted to a typed text that appears on
the screen. For instructions and demonstation on using the Block
Recognizer, tap the question mark next to the writing area.

To use Transcriber:

With Transcriber, you can use the stylus to write anywhere on the screen
as you would on paper. Unlike Letter Recognizer and Block Recognizer,
you can write a sentence or additional information. Pause after writing and
let Transcriber convert the written characters to typed characters.

1. Tap the arrow next to the Input Panel button, then tap Transcriber.

2. Write anywhere on the screen.

For instructions and demonstation on using Transcriber, with
Transcriber open, tap the question mark in the lower right corner of the
screen.

To edit typed text:

1. Select the text that you wish to edit using either one of the following:

• drag the stylus over the text
• tap twice to select a word
• tap three times to select a paragraph

2. Tap Edit on the Command bar and select an action, or use one of the
tools in the Input Panel to enter a new text.
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Writing on the screen
In any program that accepts writing, such as the Notes program, and in the
Notes tab in Calendar, Contacts, and Tasks, you can use the stylus to
write directly on the screen. Write the way you do on paper. You can edit
and format what you have written and convert the information to text at a
later time.

To write on the screen:

1. Open the Notes program.

2. Tap the Pen button to switch to the writing mode. The screen displays
blank space with lines to help you write.

3. Write your text.

NOTE Some programs that accept writing may not have the Pen
button. See the documentation for that program to find out
how to switch to writing mode.
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To edit your writing:

1. Tap and hold the stylus next to the text that you wish to select until the
insertion point appears.

2. Without lifting, drag the stylus across the text to select it.

If you accidentally write on the screen, tap Tools, then Undo and try
again. You can also select text by tapping the Pen button to deselect it
and then dragging the stylus across the screen.

3. Tap Edit on the Command bar and select an action, or use one of the
tools in the Input Panel to enter a new text.

To convert writing to text:

• Tap Tools, then Recognize.

If you want to convert only certain words, select them before tapping
Recognize. If the word is not recognized, it is left as writing.
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If the conversion is incorrect, you can select different words from a list of
alternates or return to the original writing.

1. Tap and hold the incorrect word.

2. When the pop-up menu appears, tap Alternates to display a list of
alternate words for the selection.

3. Tap the word that you want to use, or tap the writing at the top of the
menu to return to the original writing.

Tips for getting good writing recognition

• Write neatly.

• Write on the line and draw descenders below the line. Write the cross of
the “t” and apostrophes below the top line so that they are not confused
with the word above. Write periods and commas above the line.

• For better recognition, try increasing the zoom level to 300% using the
Tools menu.

• Write the letters of a word closely and leave big gaps between words so
that the device can easily tell where the words begin and end.

• Hyphenated words, foreign words tha use special characters such as
accents, and some punctuation cannot be converted.

• If you add writing to a word to change it (such as changing a “3” to an “8”)
after you attempt to recognize the word, the writing you add will not
included if you attempt to recognize the writing again.
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Drawing on the screen
You can draw on th screen in the same way that you write on the screen.
The difference between writing and drawing on the screen is how you
select items and how they can be edited. For example, selected drawings
can be resized, while writing cannot.

To create a drawing:

1. Use the stylus to make a stroke three ruled lines high. A dotted box
appears.

2. Make your drawing in or touching the drawing box and crossing three
ruled lines. If the drawing does not cross three lines, it changes to writing.

NOTE To easily work on or view your drawing, change the zoom
level by tapping Tools and selecting your desired zoom.

To edit your drawing:

1. Tap and hold the stylus on the drawing until the selection handle
appears. To select multiple drawings, deselect the Pen button then
drag to select the drawings you want.

2. Tap and hold the selected drawing, then tap an editing command on
the pop-up menu or tap a command on the Edit menu.

3. Resize the drawing by deselecting the Pen button (if selected) and
dragging a selection handle to your desired size.
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Recording a message
In any program where you can write or draw on the screen, you can also
quickly capture thoughts, reminders, and phone numbers by recording a
message. In Calendar, Tasks, and Contacts,  you can include a recording
in the Notes tab. In the Notes program, you can either create a stand-
alone recording or include a recording in a written note. If you want to
include the recording in a note, open the note first. In the Inbox program,
you can add a recording to an e-mail message.

To create a recording:

1. Hold your device with the microphone near your mouth or other source
of sound.

2. Press and hold the Record button on the device until you hear a beep.

3. While holding the Record button, make your recording.

4. To stop recording, release the Record button. You will hear two beeps.
The new recording appears in the Note list or as an embedded icon.

NOTE You can also make your recording using the buttons on the
Recording toolbar.

5. To play the recording, tap it from the list, or if embedded in a note, tap
the speaker icon.
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Using a preset message
When using Inbox or MSN Messenger, use My Text to quickly insert preset
or frequently used messages into the text entry area. To insert a message,
tap My Text and tap your desired message.

NOTE You can add text after inserting a My Text message.
However, you have to add it before sending the message.

To edit a My Text message:

1. Tap Edit in the Tools menu.

2. Tap My Text Messages.

3. Select a message and make your desired changes.
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Finding and organizing information
The Find feature on your device helps you quickly locate information.

To find information:

1. Tap  , then tap Find.

2. Enter the text that you want to find, select a data type, then tap Go to
start the search.

NOTE To quickly find information that is taking up space on your
device, select Larger than 64 KB in Type.

You can also use the File Explorer to find files on your device.

Using the File Explorer

To use the File Explorer to find and organize files:

1. Tap  , then tap Programs.

2. In the Program screen, tap the File Explorer icon.

3. Tap and hold the item that you wish to move until a pop-up menu
appears.

4. Tap an action from the pop-up menu.
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Customizing your device
You can customize your device by adjusting the settings and installing
additional software.

Adjusting settings
You can adjust the device settings to your preference.

To see the available options:

1. Tap  , then tap Settings to display the Settings screen.

2. Tap the Personal or System tab on the bottom of the screen.

You may want to adjust any one of the following items.

• Clock. Change the time or set alarms.

• Menus. Customize what appears on the  menu, and enable a pop-up
menu from the New button.

• Owner information. Enter your contact information.

• Password. Add security to your device.

• Power. Maximize battery life.

• Today. Customize the look and information displayed on the Today
screen.

NOTE Refer to the section “ASUS utilities” later in this chapter for
details on the bundled ASUS programs.
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Adding or removing programs
Programs added to your device at the factory are stored in ROM (Read-
Only Memory). You cannot remove this software, and you will never
accidentally lose ROM contents. ROM programs can be updated using
installation programs with a *.xip extension. All other programs and data
files added to your device after factory installation are stored in RAM
(Random Access Memory).

You can install any program created for your device, as long as it has
enough memory. The most popular place to find software for your device is
on the Pocket PC web site (http://www.microsoft.com/mobile/pocketpc).

To add programs using ActiveSync:

NOTE You need to install the Microsoft ActiveSync on your desktop
computer before you can synchronize and/or add programs
to your device. Refer to “Chapter 3:  Microsoft ActiveSync” for
installation instructions.

1. Determine your device and processor type so that you know which
version of the software to install. Tap  , then tap Settings. On the
System tab, tap About. In the Version tab, take note of the information
in Processor.

2. Download the program to your desktop computer (or insert the CD that
contains the program into your desktop computer). You may see a
single *.xip, *.exe, or *.zip file, a Setup.exe file, or several versions of
files for different device types and processors. Be sure to select the
program designed for the Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or documentation tha
comes with the program. Many programs provide special installation
instructions.

4. Connect your device to your desktop computer.
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5. Double-click the *.exe file.

• If the file is an installer, the installation wizard begins. Follow the
directions on the screen. Once the software is installed on your
desktop computer, the installer automatically transfers the software to
your device.

• If the file is not an installer, you will see an error message stating that
the program is valid but it is designed for a different type of computer.
You need to move this file to your device. If you cannot find any
installation instructions for the program in the Read Me file or
documentation, use ActiveSync Explore to copy the program file to
the Program Files folder on your device. For more information on
copying files using ActiveSync, see ActiveSync Help.

6. When the installation is complete, tap  , Programs, and the program
icon to switch to it.

To add a program directly from the Internet:

NOTE You need to be connected to the Internet through an optional
modem card or network card before you can add programs
directly from the Internet.

1. Determine your device and processor type so that you know which
version of the software to install. Tap  , then tap Settings. On the
System tab, tap About. In the Version tab, take note of the information
in Processor.

2. Download the program to your device straight from the Internet using
the Pocket Internet Explorer. You may see a single *.xip, *.exe, or *.zip
file, a Setup.exe file, or several versions of files for different device
types and processors. Be sure to select the program designed for the
Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or  documentation
tha comes with the program. Many programs provide special
installation instructions.

4. Tap the file, such as a *.xip or *.exe file. The installation wizard begins.
Follow the directions on the screen.
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To add a program to the Start menu:

1. Tap  , tap Settings, tap Menus, tap the Start Menu tab, and tap the
check box for the program. If you do not see the program on the list,
you can either use File Explorer on the device to move the program to
the Start Menu folder, or use ActiveSync on the desktop computer to
create a shortcut to the program and place the shortcut in  the Start
Menu folder.

2. If you are using the File Explorer on the device:

a. Tap  , tap Programs, tap File Explorer, and locate the program (tap
the folder list, labeled My Documents by default, then tap My Device
to see a list of all the folders on the device).

b. Tap and hold the program, then tap Cut on the pop-up menu. Open
the Start Menu folder located in the Windows folder, tap and hold a
blank area of the window, then tap Paste in the pop-up menu.

c. The program now appears on the  menu. For more information on
using the File Explorer, see the section “Finding and organizing
information” earlier in this chapter.

3. If you are using ActiveSync on the desktop computer:

a. Use the Explorer in ActiveSync to explore yoru device files and locate
the program. Right-click the program, then click Create Shortcut.

b. Move the shortcut to the Start Menu folder in the Windows folder. The
shortcut now appears on the  menu. For more information, see
ActiveSync Help.

To remove a program from the Start menu:

1. Tap  , then tap Settings. On the System tab, tap Remove Programs.

2. If the program does not appear in the list of installed programs, use
File Explorer on your device to locate the program, tap and hold the
program, then tap Delete on the pop-up menu.
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ASUS utilities
Besides the Microsoft program that allow you back up the data, your
device also includes a proprietary ASUS utilities. The ASUS utilities allow
you to backup or restore data, and adjust settings to customize your
device and maximize its use.

Using the ASUS Backup

To access the ASUS backup utility:

1. Tap  , then tap Programs.

NOTE You need to insert an SD (Secure Digital) memory card into
the SD slot on top of the device when backing up data.
Otherwise, you will receive the message “No storage devices
are found!”

1. Tap  , then tap Settings.

2. Tap the System tab, then tap the
Memory icon.

3. On the Memory screen, tap the
Running Programs tab.

4. Tap the Stop All button, then tap
OK.

2. Tap  , then tap .

A message appears asking you to
stop other programs before
running the backup utility.

3. Tap OK and stop running
programs.

To stop all running programs:
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1. Return to the ASUS programs
screen and tap the ASUS
Backup icon.

2. Tap the Backup tab on the ASUS
Backup screen.

3. Tap All Data button to back up all
data on your device.

Backing up data

To back up all data on your device:

4. In the Backup File screen:

• specify the backup file name
• specify the folder in which to

store the backup file (optional)

• specify the location where you
would like to place your backup
file (i.e. SD card, CF card)

5. Tap OK to start the backup
process.
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6. When the backup process is
complete, the screen displays the
message “Complete” and the total
size of the backed up files.

In case the program fails to back
up any items, it will show the
items on the screen.

7. Tap OK.

To back up only PIM data on your device:

1. On the ASUS Backup screen, tap
PIM Data button to back up only
the personal information
management (PIM) data on your
device.

2. When prompted, select SD Card
or CF card (whichever is
available).

Tapping Cancel returns you to the
previous screen.

3. Tap the Backup tab.

4. Type a name for your backup file
and the folder where you wish to
place it. You may opt not to
specify a folder.

5. Check the boxes opposite the
items that you wish to back up, or
tap Select All to select all listed
items.
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NOTE See the online help on your device for online instructions to
back up or restore data.

If you checked the box User
Defined Folders, tap Define to
specify the folders that you wish
to include in the backup file, then
tap OK.

6. Tap Start to begin the backup
process.

7. When the backup process is
complete, the screen displays the
message “Complete” and a list of
all the backed up items.

8. Tap OK.
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Restoring data

To restore all data from the memory card:

1. Tap  , then tap Programs.

NOTE You need to insert the SD memory card that contains your
backup file into the SD slot on the device when restoring
data. Otherwise, you will receive the message “No storage
device are found!”

2. On the ASUS Programs screen
Tap the ASUS Backup icon.

When prompted, stop all running
programs. See page 2-16 for
instructions.

3. Tap the Restore tab on the ASUS
Backup screen.

4. Tap All Data.

5. In the Backup File screen:

• select the backup file name
(tap the arrow to list down other
backup files, if any)

• select the folder that contains
your backup file (optional)

• select the location where you
stored your backup file (i.e. SD
card, CF card)

6. Tap OK to start the restore
process.
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1. On the ASUS Backup screen, tap
PIM Data.

2. When prompted, select SD Card
or CF card where you stored your
backup file.

Tapping Cancel returns you to the
previous screen.

3. Tap the Restore tab.

To restore PIM data from the memory card:

4. Select the backup file name  (tap
the arrow to list down other
backup files, if any).

5. Check the boxes opposite the
items that you wish to restore, or
tap Select All to select all listed
items.

If you checked the box User
Defined Folders, tap Define to
specify the folders that you wish
to restore, then tap OK.

6. Tap Start to begin the restore
process.

7. When the restore process is
finished, a message appears
prompting you to reset the PDA.
Tap OK and reset your device.
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Tap the Mode tab to display the
running  mode of the CPU.

The Turbo Mode allows better CPU
performance. In this mode, the CPU
speed goes up to 400MHz. Set to this
mode when playing games or playing
video. However, setting to Turbo
mode may reduce the battery life.

The Standard Mode allows for up to
200MHz CPU speed. Set to this
mode when listening to MP3 audio
files or for applications  that do not
require very fast CPU speed.

1. Tap  , then tap Settings.

2. Tap the System tab on the
bottom of the Settings screen.

3. Tap the ASUS Settings icon to
display  the system information
screen. This screen is displayed
whenever you tap the Info tab.

Customizing the ASUS Settings

To access the ASUS settings:

To change the Run Mode:
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The Power Saving Mode sets the CPU to a fixed speed of 100MHz. Set
to this mode when using text based applications such as Word, Excel, etc.
This mode has a lower CPU performance but extends the battery life.

The Automatic Mode allows for 100MHz, 200MHz, or 400MHz CPU
speed depending on the program that you are running.

You may also check the Advanced Performance Enhancement box to
increase system performance. This option allows data caching so you can
retrieve data faster. However, this option may sometimes cause the
system to be unstable.

Tap the Display tab to adjust the
screen brightness.

You may set the degree of brightness
on battery power and on external
power. Using a lower degree of
brightness while on battery power
substantially reduces battery power
consumption.

You will only see the Display settings
if your device has a customizable
backlight.

To change the Display settings:
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Tap the AGC tab to adjust the
settings for the microphone sensitivity
and automatic gain control (AGC).

The AGC features allows you to
adjust the recording and environment
noise level.

• The MIC Sensitivity controls the
sound recording input. Setting the
slider toward the “+” sign allows for
a louder recording, but the
environment noise level may be
louder also.

• The Gain Control controls the
sound recording output.

Tap the Wakeup tab to select the
source wakeup buttons.

Pressing any one of the checked
buttons wakes up the device.

The program assigned to a specific
button appears when you press that
button.

Tap  , Settings, and Buttons for
the button assignments. You may
customize the button assignments.

To change the Microphone settings:

To change the Wakeup Sources:
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Tap the Autorun tab to select the
source devices to execute the
autorun program.

You may select SD Card or CF card,
or both.

To select Autorun Devices:



2-26 Chapter 2



Microsoft® ActiveSync® 3-1

Chapter 3

Microsoft® ActiveSync®

♦♦♦♦♦ Introduction........................................................... 3-2
What is ActiveSync®? ............................................................... 3-2

♦♦♦♦♦ Installing ActiveSync® ......................................................................... 3-3
Installing ActiveSync® on your computer .................................. 3-4

♦♦♦♦♦ Synchronizing your device .................................. 3-5
Connecting your device to a computer .................................... 3-5

Setting up a partnership ........................................................... 3-6

Checking synchronized information ......................................... 3-6

Initiating synchronization .......................................................... 3-7

Synchronization options ........................................................... 3-8



3-2 Chapter 3

Introduction

What is ActiveSync®?
The Microsoft® ActiveSync® is one of the important bundled programs in
MyPal. With ActiveSync, you can synchronize the information on your
desktop computer with the information on your device. Synchronization
compares the data on your device with your desktop computer and
updates both computers with the most recent information.

For example:

• Keep Pocket Outlook data up-to-date by synchronizing your device with
Microsoft Outlook data on your desktop computer.

• Synchronize Microsoft Word and Microsoft Excel files between your
device and desktop computer. Your files are automatically converted to
the correct format.

NOTE By default, ActiveSync does not automatically synchronize all
types of information. Use the ActiveSync options to turn
synchronization on or off for specific information types.

With ActiveSync, you can also:

• Back up and restore your device data

• Copy (rather than synchronize) files between your device and desktop
computer

• Control when synchronization occurs by selecting a synchronization
mode. For example, you can synchronize continually while connected to
your desktop computer or only when you choose to synchronize.

• Select which information types are synchronized and control how much
data is synchronized. For example, you can choose to synchronize your
appointments of the past two weeks only, appointments older than two
weeks are not synchronized.

For more information about using ActiveSync:

1. Start ActiveSync on your desktop computer.

2. From the Activesync menu bar, click Help then on Microsoft
ActiveSync Help.
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Installing ActiveSync®

The ActiveSync program is already installed on your device. To
synchronize information on your device with your computer, you must also
install ActiveSync on your computer. Install ActiveSync from the
Companion CD that came with your product package.

NOTE Before starting the ActiveSync installation, make sure that
you have Microsoft® Outlook® installed on your computer. If
you do not have Outlook, install the Microsoft® Outlook® 2002
from the Companion CD. Even if you have Outlook 98 or
Outlook 2000 installed, you are encouraged to update to
Outlook 2002.

Installing ActiveSync® on your computer

To install ActiveSync on your computer:

1. Turn on your computer and monitor.

NOTE Do not connect your device to your computer until you have
finished installing ActiveSync.

2. Insert the Companion CD into the CD-ROM drive of your computer.
The CD autoruns and displays the initial screen, then the Main Menu
from which you can start the installation.

3. Click on Start Here from the Main Menu.
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4. Read the Overview before installing ActiveSync 3.5 to make sure that
you perform the installation sequence correctly.

5. Click Download Connection Wizard and read the overview to see if
you require the wizard. Follow the screen instructions to install the
wizard on your computer. Return to the Main Menu when done.

6. Click Install ActiveSync 3.5.

7. At the Install ActiveSync 3.5 screen, click Install.
8. At the File Download window, select Run this program from its

current location then click OK.

9. Follow the screen instructions to complete the installation.

10. Restart Windows when prompted, then proceed to the next section to
connect your device to your computer and start synchronization.

If you have not installed Outlook, install it now. Click Install Outlook
2002 and follow the screen instructions to complete the installation.
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Synchronizing your device

Connecting your device to a computer

To connect your device to your computer:

1. Place the device on the cradle.

2. Connect the AC adapter to the power connector on the cradle.

3. Connect the mini-USB sync cable to the mini-USB connector on the
cradle and the other end to a USB port on your computer.

To connect your device to
your computer without the
cradle:

1. Connect the USB sync cable with
40-pin connector to the 40-pin
sync cable connector at the
bottom of the device.

2. Connect the other end of the cable
to a USB port on your computer.

40-pin connector
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Setting up a partnership
Immediately after you have completed the installation, the New
Partnership wizard will start automatically to help you establish a
partnership and customize your synchronization settings. At this point, you
can decide exactly which types of information you would like to
synchronize with your computer. Your first synchronization process begins
when you finish using the wizard.

A partnership is a file that allows you to synchronize your device with your
desktop computer. This file is stored on your desktop computer. An additional
file that enables your desktop computer to recognize your device is stored on
your device.

Checking synchronized information
After your first synchronization, take a look at Calendar, Contacts, and
Tasks on your device. You will notice that the calendar information in
Microsoft Outlook on your computer was copied to your device, and the
information that you have on your device was copied to your computer.

NOTE Open Microsoft Outlook on your desktop computer to see the
details of copied information from your device.
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Initiating synchronization
Once you have set up ActiveSync and completed the first synchronization
process, you can initiate synchronization from your device at any time.

To manually initiate synchronization:

1. Tap  , then tap ActiveSync to display the ActiveSync screen.

2. To start synchronization, make a connection between your device and
your computer, then tap Sync.

To end synchronization, tap Stop.

For more information on synchronization:

Tap   while in the ActiveSync screen, then tap Help.
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Synchronization options
The Microsoft ActiveSync program allows you to customize your
synchronization settings at any time. You can select the items to
synchronize, set the synchronization schedule, and specify the
synchronization rules.

To display the synchronization options:

• From the ActiveSync window on your desk top computer, click on the
Options icon, or

• From the menu bar, click on Tools, then Options.

1. Check the box opposite the item
that you wish to synchronize.

2. Highlight a checked item then
click on Settings to specify
synchronization options for the
item.

For example, highlight Calendar
then click on Settings to display
the Calendar Synchronization
Settings window. Customize the
available settings, then click OK
when done.

3. Do the same for the other
checked items.

NOTE:  You cannot set the
options for unchecked items.

4. Click OK when done.

To select items to synchronize:
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To set synchronization schedule:

1. Click on the Schedule tab.

2. Select your desired
synchronization schedule.

3. Click OK when done.

To specify synchronization rules:

1. Click on the Rules tab.

2. Select your desired settings from
the available options.

3. Click OK when done.
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Introduction
Microsoft® Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and
Notes. You can use these programs individually or together. For example,
e-mail address stored in Contacts can be used to address e-mail
messages in Inbox.

Using ActiveSync®, you can synchronize information in Microsoft Outlook
or Microsoft Exchange on your desktop computer with your device. You
can also synchronize this information directly with a  Microsoft Exchange
server. Each time you synchronize, ActiveSync compares the changes you
mode on your device and desktop computer or server and updates both
computers with the latest information. For information on using ActiveSync,
see ActiveSync Help on your desktop computer.

You can switch to any of the Pocket Outlook programs by tapping .

Calendar:  Scheduling appointments
and meetings

Use Calendar to schedule appointments, including meetings and other
events. You can check your appointments in one of several views
(Agenda, Day, Week, Month, and Year) and easily switch views using the
View menu.

NOTE You can customize the Calendar display, such as changing
the first day of the week, by tapping Options on the Tools
menu.
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Creating appointments

To create an appointment:

1. If you are in Day or Week view, tap your desired date for the
appointment,

2. Tap New.

3. Using the input panel, enter a description and a location. Tap first to
select the field.

4. If needed, tap the date and time to change them.

5. Enter other desired information. You will need to hide the input panel to
see all available fields.

6. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see the “Notes:
Capturing thoughts and ideas” later in this chapter.

7. When done, tap OK to return to Calendar.

NOTE If you select Remind me in an appointment, your device will

remind you according to the options set in , Settings,
Personal tab, Sounds and Notifications.
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Using the summary screen
When you tap an appointment in Calendar, a summary screen is
displayed. To change the appointment, tap Edit.

Creating meeting requests
You can use Calendar to set up meetings with users of Outlook and
Pocket Outlook. The meeting request will be created automatically and
sent either when you synchronize Inbox or when you connect to your
e-mail server.

To create a meeting request:

1. Tap Tools then Options to indicate how you want meeting requests sent

2. If you send and receive e-mail messages through ActiveSync, select
ActiveSync.

To schedule a meeting:

1. Create an appointment.

2. In the appointment details, hide the input panel, then tap Attendees.

3. From the list of e-mail addresses you have entered in Contacts, select
the meeting attendees.

The meeting notice is created automatically and place in the Outbox
folder. For more information on sending and receiving meeting
requests, see Calendar Help and Inbox Help on the device.
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Contacts:  Tracking friends and
colleagues

Contacts maintains a list of your friends and colleagues so that you can
easily find the information you look for, whether you are at home or on the
road. Using the infrared port (IR) on the device, you can quickly share
Contacts information with other device users.

NOTE To change the way information is displayed in the list, tap
Tools then Options.
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Creating contacts

To create a contact:

1. Tap  , then tap Contacts.

2. Tap New to display a blank contact form.

3. Using the input panel, enter a name and other contact information. You
will need ot scroll down to see all available fields.

4. To assign the contact a category, scroll to and tap Categories, then
select a category from the list. In the contact list, you can display the
contacts by category.

5. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes:
Capturing thoughts and ideas” later in this chapter.

6. Tap OK to return to the contact list when done.
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Finding a contact
There are four ways to find a contact.

• In the contact list, enter a contact name in the box under the navigation
bar. To show all contacts again, clear text from the box or tap the button
to the right of the box.

• In the contact list, tap the category list (labeled All Contacts by default)
and select the type of contact that you wish to display. To show all
contacts again, select All Contacts. To view a contact not assigned to a
category, select None.

• To view the names fo companies your contacts work for, in the contact
list, tap View > By Company. The number of contacts that work for that
company will be displayed to the right of the company name.

• Tap  , Find, enter the contact name, select Contacts for the type, and
tap Go.

Using the summary screen
When you tap a contact in the contact list, a summary screen is displayed.
To change the contact informaton, tap Edit.
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Tasks:  Keeping a to do list
Use Tasks ot keep track of what you have to do.

Creating tasks

To create a task:

1. Tap  , then tap Tasks.

2. Tap New to display a blank task form.
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3. Using the input panel, enter a description.

4. You can enter a start date and due date or enter other information by
tapping the field first. If the input panel is open, you will need to hide it
to see all available fields.

5. To assign the task to a category, tap Categories and select a catagory
from the list. In the task list, you can display tasks by category.

6. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes:
Capturing thoughts and ideas” later in this chapter.

7. Tap OK to return to the task list when done.

NOTE To quickly create a task with only a subject, tap Entry Bar on
the Tools menu. Tap Tap here to add a new task and enter
your task information.

Using the summary screen
When you tap a task in the task list, a summary screen is displayed. To
change the task, tap Edit.
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Notes:  Capturing thoughts and
ideas

Quickly capture thoughts, reminders, ideas, and phone numbers with
Notes. You can create a written note or a recording. You can also include a
recording in a note. If a note is open when you create the recording, it will
be included in the note as an icon. If the note is displayed, it will be
created as a stand-alone recording.
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Creating notes

To create a note:

1. Tap  , then tap Notes.

2. Tap New to display a blank note.

3. Create your note by writing, drawing, typing, or recording. For more
information about using the input panel, writing and drawing on the
screen, and creating recordings, see Chapter 2.
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Inbox:  Sending and receiving e-mail
messages

Use Inbox to send and receive e-mail messages in one of these ways:

• Synchronize e-mail messages with Microsoft Exchange of or Microsoft
Outlook on your desktop computer

• Send and receive e-mail messages by connecting directly to an e-mail
server through an Internet service provider (ISP) or a network

Synchronizing e-mail messages
E-mail messages can be synchronized as part of the general
synchronization process. You will need to enable Inbox synchronization in
ActiveSync. For more information on enabling Inbox synchronization, see
ActiveSync Help on your desktop computer.

During synchronization:

• Messages are copied from the mail folders of Exchange or Oultook on
your desktop computer to the ActiveSync folder in Inbox on your device.
By default, you will receive messages from the past three days only, the
first 100 lines of each message, and file attachments of less than 100KB
in size.

• E-mail messages in the Outbox folder on your device are transferred to
Exchange or Outlook, then send from those programs.

• E-mail messages in subfolder must be selected in ActiveSync on your
desktop computer in order to be transferred.

NOTE You can also synchronize e-mail messages with your desktop
computer from a remote location. For more information, see
Chapter 7.
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Connecting directly to an e-mail server
In addition to synchronizing e-mail messages with your desktop computer,
you can send and receive e-mail messages by connecting to an e-mail
server using a modem or network card connected to your device. You
need to set up a remote connection to a network or an ISP, and a
connection to your e-mail server. For more information, see Chapter 7.

When you connect to the e-mail server, new messages are downloaded to
the devie Inbox folder, messages in the device Outbox folders are sent,
and messages that have been deleted on the e-mail server are removed
from the device Inbox folder.

Messages that you receive directly from an e-mail server are linked to your
e-mail server rather than your desktop computer. When you delete a
message on your device, it is also deleted from the e-mail server the next
time you connect based on the settings you selected in ActiveSync.

You can work online or offline. When working online, you read and
respond to messages while connected to the e-mail server. Messages are
sent as soon as you tap Send, which saves space in your device.

When working offline, once you have downloaded now message headers
or partial messages, you can disconnect from the e-mail server and decide
which messages to download completely. The next time you connect,
Inbox downloads the complete messages you have marked for retrieval
and sends the messages you have composed.
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Using the message list
Messages you receive are displayed in the message list. By default, the
most recently received messages are displayed first in the list.

When you receive a message. tap it to open it. Unread messages are
displayed in bold.



Microsoft® Pocket Outlook 4-15

When you connect to your e-mail server or synchronize with your desktop
computer, by default, you will receive messages from the last five days
only, the first 100 lines of each new messages, and file attachments of less
than 100KB in size. The original messages remain on the e-mail server or
your desktop computer.

You can mark the messages that you want to retrieve in full during your
next synchronization or e-mail server connection. In the message list, tap
and hold the message that you want to retrieve. On the pop-up menu, tap
Mark for Download. The icons in the Inbox message list give you visual
indications of message status.

You specify your downloading preferences when you set up the service or
select your synchronization options. You can change them at any time.

• Change options for Inbox synchronization using ActiveSync options. For
more information, see ActiveSync Help on your desktop computer.

• Change options for direct e-mail server connections in Inbox on your
device. Tap Tools then Options. On the Service tab, tap the service that
you wish to change. Tap and hold the service and select Delete to
remove a service.
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Composing messages

To compose a message:

1. Tap New.

2. In the To field, enter an e-mail or SMS address of one or more
recipients, separating them with a semicolon, or select a name from
the Contacts list by tapping the Address Book button. All e-mail
addresses entered in the e-mail fields in Contacts appear in the
Address Book.

3. Compose your message. To enter preset or frequently used messages,
tap My Text and select a message.

4. Tap Send when you have finished the message. If you are working
offline, the message is moved to the Outbox folder and will be sent the
next time you connect.
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Managing e-mail messages and folders
The behavior of the folders you create depends on whether you are using
ActiveSync, SMS, POP3, or IMAP4.

• If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will
automatically be sunchronized with your device. You can select to
synchronize additional folders by designating them for ActiveSync. The
folders you create and the messages you move will then be mirrored on
the server. For example, if you move two messages from the Inbox folder
to a folder named Family, and you have designated Family for
synchronization, the server creates a copy of the Family folder and
copies the messages into that folder. You can then read messages while
away from your desktop computer.

• If you use SMS, messages are stored in the Inbox folder.

• If you use POP3 and you move e-mail messages to a folder you created,
the link is broken between the messages on the device and their copies
on the mail server. The next time you connect, the mail server will see
that the messages are missing from the device Inbox and delete them
from the server. This prevents you from having duplicate copies of a
message, but it also means that you will no longer have access to
messages that you move to folders created from anywhere except the
device.

• If you use IMAP4, the folders you create and the e-mail messages you
move are mirrored on the server. Therefore, messages are available to
you anytime you connect to your mail server, whether it is from your
device or desktop computer. This synchronization of folders occurs
whenever you connect to your mail server, create new folders, or
rename/delete folders when connected.
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The companion programs consist of Microsoft® Pocket Word, Microsoft®

Pocket Excel, Microsoft® Money, Windows Media™ Player for Pocket PC,
and Microsft® Reader.

To switch to a companion program on your device, tap Programs on the
 menu, then tap the program that you wish to open.

Pocket Word
Pocket Word works with Microsoft Word on your desktop computer to give
you easy access to copies of your documents. You can create new
documents on your device, or you can copy documents from your desktop
computer to your device. Synchronize documents between your desktop
computer and your device so that you have the most up-to-date content in
both locations.

Use Pocket Word to create documents, such as letters, meeting minutes,
and trip reports.

Pocket Word contains a list of the files stored on your device. Tap a file in
the list to open. To delete, make copies of, and send files, tap and hold a
file in the list, then select the appropriate action on the pop-up menu.

NOTE You can open only one Pocket Word document at a time;
when you open a second document, you will be asked to
save the first.
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Saving Pocket Word documents

To save a Word document:

When you have finished editing your document, tap OK.

The document is saved using the first line as file name. For example, if
your first line in the document has the words For Translation, these
words appear in your Word documents list.

1. Tap  , tap Programs, tap
Pocket Word.

2. Tap New to display a blank
document.

If you selected a template for new
documents in the Options dialog
box, that template appears with
the appropriate text and
formatting already provided.

Creating Pocket Word documents

To create a new Word document:
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To specify save options:

1. With the document open, tap
Tools.

2. From the pop-up menu, tap Save
Document As... to display the
Save As screen.

3. Change the file name by simply
typing a new one in the Name
field.

4. Tap the down arrow in the Folder
field to select a folder where you
wish to place the file.

NOTE If you do not wish to change the document format, but would
like to change the file name, folder, and location of your
document, simply tap Edit from the command bar, then tap
Rename/Move... from the pop-up menu to make your
changes.

5. Tap the down arrow in the Type field to select a file format.

You can save the document you create or edit in a variety of formats:

• Word (.doc)

• Pocket Word (.psw)

• Rich Text Format (.rtf)

• Plain Text (.txt)

6. Tap the down arrow in the Location field to indicate the location of
your saved file, either in the main memory of your device, or in a
storage card (SD or MMC) if available.

7. Tap OK when done.
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Modes of entering information
You can enter information in Pocket Word in one of four modes (typing,
writing, drawing, or recording), which are displayed on the View menu.
Each mode has its own toolbar that you can show or hide by tapping the
Show/Hide Toolbar button on the command bar.

If you are opening a Word document created on a desktop computer,
select Wrap to Window on the View menu so that you can see the entire
document.

To change the zoom magnification:

1. Tap View, then tap Zoom.

2. Select your desired percentage.

Select a higher percentage to enter text and lower one to see more of
your document.

Typing Mode

Using the input panel, enter typed text into the document. For more
information on entering typed text, see Chapter 2.

To format existing text and to edit text, first select the text. You can select
text as you do in a Word document, using your stylus instead of the mouse
to drag through the text you want to select. You can search a document to
find text by tapping Edit and Find/Replace.
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Writing mode

In writing mode, use your stylus to write directly on the screen. Ruled lines
are displayed as a guide, and the zoom magnification is greater than in
typing mode to allow you to write more easily. For more information on
writing and selecting writing, see Chapter 2.

NOTE If you cross three ruled lines in a single stylus stroke, the
writing becomes a drawing, and can be edited and
manipulated as described in the next section.

Written words are converted to graphics (metafiles) when a
Pocket Word document is converted to a Word document on
your desktop computer.
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Drawing mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear
as a guide. When you lift your stylus off the screen after ther first stroke,
you will see a drawing box indicating the boundaries of the drawing. Every
subsequent stroke within or touching the drawing box becomes part of the
drawing. For more information on drawing and selecting drawings, see
Chapter 2.

Recording mode

In recording mode, embed a recording into your document. Recordings are
saved as .wav files. For more information on recording, see Chapter 2.
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Pocket Excel
Pocket Excel works with Microsoft Excel on your desktop computer to give
you easy access to copies of your workbooks. You can create new
workbooks on your device, or you can copy workbooks from your desktop
computer to your device. Synchronize workbooks between yoru desktop
computer and your device so that you have the most up-to-date contents
in both locations.

Use Pocket Excel to create workbooks, such as expense reports and
mileage logs.

Pocket Excel contains a list of the files stored on your device. Tap a file in
the list to open. To delete, make copies of, and send files, tap and hold a
file in the list, then select the appropriate action on the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas,
functions, sorting, and filtering. To display the toolbar, tap View, then tap
Toolbar.

NOTE You can open only one Pocket Excel document at a time;
when you open a second document, you will be asked to
save the first.
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Saving Pocket Excel documents

To save an Excel document:

When you have finished editing your document, tap OK.

By default, your document is saved as Book1 as file name. You can
change the file name to one that is more descriptive of your document.
See next section for saving options.

1. Tap  , tap Programs, tap
Pocket Excel.

2. Tap New to display a blank
document.

If you selected a template for new
documents in the Options dialog
box, that template appears with
the appropriate text and
formatting already provided.

Creating Pocket Excel documents

To create a new Excel document:
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To specify save options:

1. With the document open, tap
Tools.

2. From the pop-up menu, tap Save
Workbook As... to display the
Save As screen.

3. Change the file name by simply
typing a new one in the Name
field.

4. Tap the down arrow in the Folder
field to select a folder where you
wish to place the file.

NOTE If you do not wish to save your workbook to a different format,
but would like to change the file name, folder, and location of
your document, simply tap Edit from the command bar, then
tap Rename/Move... from the pop-up menu to make your
changes.

5. Tap the down arrow in the Type field to select a file format.

You can save the document you create or edit in a variety of formats:

• Pocket Excel (.pxl)

• Excel (.xls)

6. Tap the down arrow in the Location field to indicate the location of
your saved file, either in the main memory of your device, or in a
storage card (SD or MMC) if available.

7. Tap OK when done.
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Securing your Excel document
If your workbook contains sensitive or confidental information, you can
protect it with a password.

To set a password for your workbook:

1. Open the workbook.

2. Tap Edit from the command bar,
then tap Password... to display
the password setting screen.

3. Type a password in the
Password field.

4. Re-type the password in the
Verify Password field.

5. Tap OK when done.

If you have set a password for your
workbook, a password screen
appears asking you to type your
password whenever you try to open
the workbook.

Type your password, then tap OK. If
you type in a wrong password, a
message appears telling you so.

NOTE DO NOT forget your password. You can not open your
workbook unless you type in the correct password.
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Tips for working in Pocket Excel
Take note of the following when working in large worksheets in Pocket
Excel:

• View in full-screen mode to see as much of your worksheet as
possible. Tap View, then tap Full Screen. To exit full-screen mode, tap
Restore.

• Show and hide window elements. Tap View, then tap the elements to
show or hide.

• Freeze panes on a worksheet. First select the cell where you want to
freeze panes. Tap View, then tap Freeze Panes. You might want to
freeze the top and leftmost panes in a worksheet to keep row and
column labels visible as you scroll through a sheet.

• Split panes to view different areas of a large worksheet. Tap View, then
tap Split. Drag the split bar to where you want it. To remove the split, tap
View, then tap Remove Split.

• Show and hide rows and columns. To hide a row or column, select a
cell in the row or column that you want to hide. Tap Format, then tap
Row or Column, and tap Hide. To show a hidden row or column, tap
Tools, then tap Go To, and type a reference that is in the hidden row or
column. Tap Format, then tap Row or Column, and tap Unhide.

For more information on using Pocket Excel, tap  , then tap Help.
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MSN Messenger
MSN Messenger on your device is an instant messaging program that
allows you to:

• See who is online

• Send and receive instant messages

• Have instant message conversations with groups of contacts/

To use MSN Messenger, you must have a Microsoft Passport™ account or
a Microsoft Exchange e-mail account. You must have a Passport to use
the MSN Messenger Service. If you have a Hotmail® or MSN account, you
already have a passport. Once you have obtained either a Microsoft
Passport or Microsoft Exchange account, you are ready to set up your
account.

Sign up for a Microsoft Passport account at http://www.passport.com.

Get a free Microsoft Hotmail e-mail address at http://www.hotmail.com.

To switch to MSN Messenger, tap  , tap Programs, then tap MSN
Messenger.

Setting up
Before you can connect, you must enter your Passport or Exchange
account information.

To set up an account and sign in:

1. Tap Options in the Tools menu.

2. In the Accounts tab, enter your Passport or Exchange account
information.

3. To sign in, tap the sign-in screen and enter your e-mail address and
password.

NOTE If you already use MSN Messenger on your desktop
computer, your contacts will show up on your device without
being added again.
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Working with contacts
The MSN Messenger window shows all of your messenger contacts at a
glance, divided into Online and Not Online categories. From this view,
while connected, you can chat, send an e-mail, block the contact from
chatting with you, or delete contacts from your list using the pop-up menu.

To see others online without being seen, tap My Status in the Tools menu
and select Appear Offline.

If you block a contact, you will appear offline but will remain on the blocked
contact’s list. To unblock a contact, tap and hold the contact, then tap
Unblock on the pop-up menu.
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Chatting with contacts
Tap a contact name to open a chat window. Enter yor message in the text
entry area at the bottom of the screen, or tap My Text to enter a preset
message, then tap Send. To invite another contact to a multi-user chat, tap
Invite in the Tools menu, then tap the contact that you want to invite.

NOTE To switch back to the main window without closing a chat, tap
the Contacts button. To go back to your chat window, tap
Chats and select the person whom you were chatting with.

To know if the contact you are chatting with is responding, look for the
message under the text entry area. For more information on using MSN
Messenger, tap  , then tap Help.
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Windows Media Player for Pocket PC
Use Microsoft® Windows Media Player for Pocket PC to play digital audio
and video files that are stored on your device or on a network. To switch to

Windows Media Player for Pocket PC, tap  , tap Programs, then tap
Windows Media.

Use Microsoft Windows Media Player on your desktop computer to copy
digital audio and video to your Pocket PC. You can play Windows Media
and MP3 files on your Pocket PC.

For more information on using Windows Media Player for Pocket PC, tap
 , then tap Help.
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Microsoft Reader
Use Microsoft Reader to read eBooks on your device. Download books to
your desktop computer from your favorite eBook web site. Then, use
ActiveSync to copy the book files to your activated device. The books
appear in the Reader Library.

Each book consists of a cover page, an optional table of contents, and the
pages of the book. You can:

• Page through the book using the Up/Down control on your device, or by
tapping the page number on each page.

• Annotate the book with highlighting, bookmarks, notes, and drawings.

• Search for text and look up definitions for words.

The Guidebook contains all the information that you need to use the
software. To open  the Guidebook, tap Help on the Reader command bar.
Or, on a book page, tap and hold on the book title, then tap Help on the
pop-up menu.

To switch to Microsoft Reader, tap  , tap Programs, then tap Microsoft
Reader.

Getting books on your device
You can download book files from the Web. Just visit your favorite eBook
retailer and follow the instructions to download the book files.

Sample books and a dictionary ar also included in the MSReader folder in
the Extras folder on the Pocker PC Companion CD.

Use ActiveSync to download the files from your desktop computer to your
activated device as described in the Read Me file in the MSReader folder.



5-18 Chapter 5

Using the Library
The Library is your Reader home page. It displays a list of all books stored
on your device or storage card.

To open the library:

1. On the Reader command bar, tap Library.

2. On a book page, tap the book title, then tap Library on the pop-up
menu.

To open a book, tap its title in the Library list.
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Reading a book
Each book consists of a cover page, and optional table of contents, and
the pages of the book. Navigation options are listed in the bottom portion
of the cover page.

The first time you open a book, you will probably want to go to the first
page or to the table of contents, if there is one. Subsequently, whenever
you open a book, you will be automatically taken to the last page read.

In addition to the text, each book page includes a page number and the
book title.

You can also page through a book using the Up/Down control on your
device.
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Using Reader features
Reading a book electronically gives you several options not available with
paper books. These options are available from any book page.

Select text by dragging across the text on the page. Tehn, tap an option on
the pop-up menu, as described below.

• Search for Text. Find text in a book by tapping Find on the pop-up
menu. Enter the word you want to search for, and tap the desired Find
option. Reader highlights found text on the page. To close Find, tap
outside the box. To return to your original page, tap the title then tap
Return on the pop-up menu.

• Copy Text. You can copy text form books that support this feature into
any program that accepts text. On a book page, select the text that you
want to copy. Then, tap Copy Text on the pop-up menu. The text can be
pasted into the program of your choice.

• Bookmarks. When you add a bookmark to a book, a color-coded
bookmark icon appears on the right margin. You can add multiple
bookmarks to a book. Then, from anywhere in the book, tap the
bookmark icon to go to the bookmarked page.

• Highlights. When you highlight text, it appears with a colored
background.

• Notes. When you attach a note to text, you enter the text in a note pad
that appears on top of the book page. A Note icon appears on the left
margin. To show or hide the note, tap the icon.

• Drawings. When you add a drawing, a Drawing icon appears on the
bottom-left corner of the page, and drawing tools appear across the
bottom of the page. Draw by dragging your stylus.

NOTE To see a list of a book’s annotations, including bookmarks,
highlights, text notes, and drawings, tap Annotations Index
on the book’s cover page. You can tap an entry in the list to
go to the annotated page.

Removing a book
When you finish reading a book, you can delete it to conserve space on
your device. If a copy of the book  is stored on your desktop computer, you
can download it again at any time.

To remove a book from your device, tap and hold the title in the Library list,
then tap Delete on the pop-up menu.
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Introduction
Use Microsoft Pocket Internet Explorer to view Web or WAP pages in any
of these ways.

• During synchronization with your desktop computer, download your
favorite links and mobile favorites that are stored in the Mobile Favorites
sub-folder in the Internet Explorer on the desktop computer.

• Connect to an Internet service provider (ISP) or network and browse the
Web. To do this, you need to create the connection first. See Chapter 7
for information on creating a connection.

When connected to an ISP or network, you can also download files and
programs from the Internet or intranet.

To switch to Pocket Internet Explorer, tap   then tap Internet Explorer.

The Mobile Favorites folder
Only items items stored in the Mobile Favorites sub-folder in the Favorites
folder in the Internet Explorer on your desktop computer will be
synchronized with your device. This folder was created automatically when
you installed ActiveSync.

Favorite links
During synchronization, the list of favorite links in the Mobile Favorites
folder on your desktop computer is synchronized with Pocket Internet
Explorer on your device. Both computers are updated with changes made
to either list each time you synchronize. Unless you mark the favorite link
as a mobile favorite, only the link will be downloaded to your device, and
you will need to connect to your ISP or network to view the content. For
more information on synchronization, see ActiveSync Help on the desktop
computer.

Mobile Favorites
If you are using Microsoft Internet Explorer 5.0 or later on your desktop
computer, you can download mobile favorites to your device.
Synchronizing mobile favorites downloads Web content to your device so
that you can view pages while you are disconnected from your ISP and
desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile
favorites quickly.
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To create a mobile favorite:

1. In Internet Explorer on your desktop computer, click Tools then Create
Mobile Favorite.

2. To change the link name, enter a new name in the Name box.

3. Select your desired update schedule in Update. This is optional.

4. Click OK. Internet Explorer downloads the latest version of the page to
your desktop computer.

5. If you want to download the pages that are linked to the mobile favorite
you just created, in Internet Explorer on the desktop computer, right-
click the mobile favorite, then click Properties. In the Download tab,
specify the number of links deep you want to download. To conserve
device memory, go only one level deep.

6. Synchronize your device an desktop computer. Mobile favorites that
are stored in the Mobile Favorites in Internet Explorer are downloaded
to your device.

NOTE If you did not specify an update schedule in step 3, you will
need to manually download content to keep the information
updated on your desktop computer and device. Before
synchronizing with your device, in Internet Explorer on your
desktop computer, click Tools then Synchronize. You will
see the last time content was downloaded to the desktop
computer, and you can manually download content if needed.

You can add a button to the Internet Explorer toolbar for
creating mobile favorites. In Internet Explorer on your desktop
computer, click View, Toolbars, and Customize.

Saving device memory

Mobile favorites take up storage memory on your device. To minimize the
amount of memory used:

• In the settings for the Favorites information type in ActiveSync options,
turn off pictures and sounds, or stop some mobile favorites from being
downloaded to the device. For more information, see ActiveSync Help.

• Limit the number of downloaded linked pages. In Interner Explorer on
your desktop computer, right-click the mobile favorite you want to
change, then click Properties. In the Download tab, specify 0 or 1 for
the number of linked pages you want to download.
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Using AvantGo Channels
AvantGo is a free interactive service that gives you access to personalized
content and thousands of popular Web sites. You subscribe to AvantGo
channels directly from your device. Then, synchronize your device and
desktop computer, or connect to the Internet to download the content. For
more information, visit the AvantGo Web site.

To sign up for AvantGo:

1. In ActiveSync options on your desktop computer, turn on
synchronization for the AvantGo information type.

2. In Pocket Internet Explorer on your device, tap the Favorites button to
display your list of favorites.

3. Tap the AvantGo Channels link.

4. Tap the Activate button.

5. Follow the instructions on the screen. You will need to synchronize
your device with your desktop computer, then tap My Channels button
to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your
list of favorites to see a few of the most popular channels. To add or
remove channels, tap the Add or Remove link.
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Using Pocket Internet Explorer
You can use Pocket Internet Explorer to browse mobile favorites and
channels that have been downloaded to your device without connecting to
the Internet. You can also connect to the Internet through an ISP or a
network connection to browse the Web.

To launch Pocket Internet Explorer, tap  , then Internet Explorer. A
welcome screen appears with links to some useful Web sites. Tap any of
the Web site buttons to go to a specific site.

The buttons on the command bar allow you to switch between screens,
customize screen display, and set Pocket Internet Explorer preferences.

Tap here to browse
a web site

Hide/Show pictures button
Favorites buttonHome button

Refresh button

Changing View settings

To change View settings:

1. Tap View to display a pop-up menu.

2. Tap Fit to Screen to see all the screen items at the same time.

3. Tap Address Bar to display the Web site address bar.

4. Tap and hold Text Size to display another pop-up menu with a text size
selection. Select your desired text size for the screen.
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Viewing mobile favorites and channels

To view mobile favorites and channels:

1. Tap the Favorites button to display your list of favorites.

2. Tap a Favorites page that you wish to view.

You will see the page that was downloaded the last time you
synchronized with your desktop computer. If the page is not on yoru
device, the favorite is dimmed. You need to synchronize with your
desktop computer again to download the page to your device, or
connect to the Internet to view the page.

Tap the favorite that
you wish to view

Tap to add or delete a
folder or favorite link
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Adding/Deleting mobile favorites and folders

To add a favorite:
1. Tap the Favorites button to

display your list of favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Tap the Add... button to show the
Add Favorite screen.

4. Type a name for the favorite that
you wish to add in the Name field.

5. Type in the URL address in the
Address (URL) field.

6. Select a folder to place the
favorite from the Create in: box.

7. Tap Add to return to the Favorites
screen, which now shows the
favorite that you added.

To delete a favorite:

1. Tap the Favorites button to
display your list of favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Select the favorite that you wish
to delete, then tap Delete.

4. When prompted to permanently
delete the favorite, tap Yes.
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To add a folder:

1. Tap the Favorites button to
display your list of favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Tap the New Folder button.

4. Type a name for the folder that
you wish to create.

5. Tap Add to return to the Favorites
screen, which now shows the
folder that you added.

To delete a folder:

1. Tap the Favorites button to
display your list of favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Select the folder that you wish to
delete, then tap Delete.

4. When prompted to permanently
delete the folder, tap Yes.

Browsing the Internet

To browse the Internet:

1. Set up a connection to your ISP or corporate network using
Connections. See Chapter 7 for details.

2. Do one of the following to connect and start browsing:

• Tap the Favorites button, then tap the favorite that you wist to view.

• Tap View, then Address Bar. Enter the Web address that you want
to visit then tap Go.
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Introduction
You can use your device to exchange information with other mobile
devices as well as your desktop computer, a network, or the Internet.

To get connected:

• Use the infrared (IR) port on your device to send and receive files
between two devices. If this is the method that you want to use, see the
following section “Transfer items using infrared.”

• Connect to your Internet service provider (ISP). Once connected, you
can send and receive e-mail messages using the Inbox and view Web or
WAP pages using the Microsoft® Pocket Internet Explorer. The
communication software for creating an ISP connection is already
installed on your device. You service provider will provide the software
needed to install other services, such as paging and fax services. If this
is the method that you want to use, see “Connect to an Internet Service
Provider” later in this chapter.

• Connect to the network at your company or organization where you
work. Once connected, you can send or receive e-mail messages using
Inbox, view Web or WAP pages using the Microsoft® Pocket Internet
Explorer, and synchronize with your desktop computer. If this is the
method that you want to use, see “Connect to work” later in this chapter.

• Connect to your desktop computer to synchronize remotely. Once
connected, you can synchronize information such as yoru Pocket
Outlook information. If this is the method that you want to use, see
ActiveSync Help on your desktop computer or Connections Help on the
device.
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Transfer items using infrared
Using infrared (IR), you can send and receive information, such as
contacts and appointments, between two devices.

Sending information

To send information:

1. Switch to the program where you created the item that you want to
send, and locate that item in the list.

2. Align the IR ports so that they are unobstructed and within a close
range.

3. Tap and hold the item, then tap Beam Item on the pop-up menu.

NOTE You can also send items, but not folders, from File Explorer.
Tap and hold the item that you want to send, then tap Beam
File on the pop-up menu.

Receiving information

To receive information:

1. Align the IR ports so that they are unobstructed and within a close
range.

2. Have the owner of the other device send the information to you. Your
device will automatically receive it.

Connect to the Internet
You can connect to your ISP, and use the connection to send and receive
e-mail messages and view Web or WAP pages.

You can connect to the Internet in one of these ways:

• Create a modem connection. If this is the method that you want to use,
see “To create a modem connection to an ISP.”

• Use an Ethernet card and a net tap to connect to a network. If this is the
method that you want to use, see “To create an Ethernet connection to
an ISP.”



7-4 Chapter 7

Connecting through a modem

To create a modem connection to an ISP:

1. Obtain the following information from your ISP:  ISP dial-up access
telephone number, user name, password, and TCP/IP settings. Some
ISPs require information in front of the user name, such as
MSN/username.

2. If your device does not have a built-in modem, install a modem card, or
use a NULL modem cable and appropriate adapters to connect to an
external modem to your device through the serial port.

3. Tap  , then tap Settings. In the Connections tab, tap Connections.
Under The Internet settings, select Internet Settings and tap Modify.

4. In the Modem tab, tap New.

5. Enter a name for the connection, such as “ISP Connection.”

6. In the Select a Modem list, select your modem type. If your modem
type does not appear in the list, try re-inserting the modem card. If you
are using an external modem that is connected to your device with a
cable, select Hayes Compatible on COM1.

7. You should not need to change any settings in Advanced. Most ISPs
now use a dynamically-assigned address. If the ISP you are
connecting to does not use a dynamically-assigned address, tap
Advanced, then tap the TCP/IP tab and enter the address. When done,
tap OK and Next.

8. Enter the access phone number, and tap Next.

9. Select other desired options, and tap Finish.

10. In the Dialing Locations tab, specify your current location and phone
type (most phone lines are tone). These settings will apply to all
connections you create.
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To start the connection, simply start using one of the following programs.
Your device will automatically begin connecting. Once connected, you can:

• Send and receive e-mail messages using Inbox. Before you can use
Inbox, you need to provide the information it needs to communicate with
the e-mail server. For specific instructions, see “Connect directly to an
e-mail server,” later in this chapter.

• Visit Web and WAP pages using Pocket Internet Explorer. For more
information, see Chapter 6.

• Send and receive instant messages with MSN Messenger. For more
information, see “MSN Messenger” in Chapter 5.

Connecting through an Ethernet card

To create an Ethernet connection to an ISP:

1. You do not need to create a new connection on your device. Instead,
you must purchase and configure an Ethernet card that is compatible
with your device.

2. Obtain the following information from your ISP: user name, password,
and domain name.

3. Insert the Ethernet card into your device. For instructions on inserting
and using the Ethernet card, see the owner’s manual for the card.

4. The first time you insert the card, Network Settings will appear
automatically so that you can configure the Ethernet card. Most
networks use DHCP, so you should not have to change these settings
unless your network administrator instructs you to do so. Tap OK.

If it does not appear, or to change the settings later, tap  , then tap
Settings. In the Connections tab, tap Network, tap the adapter that you
want to change, then tap Properties.

5. Connect the Ethernet card to the network using a network cable. For
information, see your owner’s manual.

6. Tap  , Settings, Connections tab, and Connections. From My
network card connects to list, select Internet.

To connect, use one of the programs listed in the preceding section. Once
connected, you can perform the same activities as listed in the preceding
section.
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Connect to work
If you have access to a network at work, you can send e-mail messages,
view intranet pages, synchronize your device, and possibly access the
Internet.

You can connect to work in one of these ways:

• Create a modem connection using a RAS account. Before you cna
create this modem connection, your network administrator will need to
set up a RAS account for you. If this is the method that you want to use,
see “To create a modem connection to a network.” Your network
administrator may also give you VPN settings.

• Use an Ethernet card and a net tap to connect to the network. If this is
the method that you want to use, see “To create an Ethernet connection
to the network.”

Connecting through a modem

To create a modem connection to a network:

1. Obtain the following information from your network administrator:  dial-
up access telephone number, user name, password, domain name,
and TCP/IP settings.

2. If your device does not have a built-in modem, install a modem card.

3. Tap  , then tap Settings. In the Connections tab, tap Connections.
Under The Internet settings, select Internet Settings and tap Modify.

4. In the Modem tab, tap New.

5. Enter a name for the connection, such as “Company Connection.”

6. In the Select a Modem list, select your modem type. If your modem
type does not appear in the list, try re-inserting the modem card. If you
are using an external modem that is connected to your device with a
cable, select Hayes Compatible on COM1.

7. You should not need to change any settings in Advanced. Most ISPs
now use a dynamically-assigned address. If the ISP you are
connecting to does not use a dynamically-assigned address, tap
Advanced, then tap the TCP/IP tab and enter the address. When
done, tap OK and Next.

8. Enter the access phone number, and tap Next.
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9. Select other desired options, and tap Finish.

10. In the Dialing Locations tab, specify your current location and phone
type (most phone lines are tone). These settings will apply to all
connections you create.

To start the connection, simply start using one of the following programs.
Your device will automatically begin connecting. Once connected, you can:

• Send and receive e-mail messages using Inbox. Before you can use
Inbox, you need to provide the information it needs to communicate with
the e-mail server. For specific instructions, see “Connect directly to an
e-mail server,” later in this chapter.

• Visit Internet or intranet Web and WAP pages using Pocket Internet
Explorer.

• Send and receive instant messages with MSN Messenger. For more
information, see “MSN Messenger” in Chapter 5.

• Synchronize. For more information, see ActiveSync Help on the desktop
computer.

Connecting through an Ethernet card

To create an Ethernet connection to a network:

1. You do not need to create a new connection on your device. Instead,
you must purchase and configure an Ethernet card that is compatible
with your device.

2. Obtain the following information from your network administrator: user
name, password, and domain name.

3. Insert the Ethernet card into your device. For instructions on inserting
and using the Ethernet card, see the owner’s manual for the card.

4. The first time you insert the card, Network Settings will appear
automatically so that you can configure the Ethernet card. Most
networks use DHCP, so you should not have to change these settings
unless your network administrator instructs you to do so. Tap OK.

If it does not appear, or to change the settings later, tap  , then tap
Settings. In the Connections tab, tap Network, tap the adapter that
you want to change, then tap Properties.

5. Connect the Ethernet card to the network using a network cable. For
information, see your owner’s manual.
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6. Tap  , Settings, Connections tab, and Connections. From My
network card connects to list, select Work.

7. If you want to synchronize your device, tap  , then ActiveSync. In the
Tools menu, tap Options. In the PC tab, select Include PC when
synchronizing remotely and connect to, and select your computer’s
name. Remote synchronization with a desktop computer will work only
if you have set up a partnership with that computer through ActiveSync
and have set ActiveSync to allow remote connections. Other
restrictions apply. For more information on synchronizing remotely, see
ActiveSync Help on your desktop computer.

To connect, use one of the programs listed in the preceding section. Once
connected, you can perform the same activities as listed in the preceding
section.

End a connection
To disconnect, do one of the following:

• When connected via dial-up or VPN, tap the Connection icon on your
navigation bar, then tap End.

• When connected via cable or cradle, detach your device from the cable
or cradle.

• When connected via Infrared, move the device away from the PC.

• When connected via a network (Ethernet) card, remove the card from
your device.
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Connect directly to an e-mail server
You can set up a connection to an e-mail server so that you can send and
receive e-mail messages using a modem or network connection and Inbox
on your device.

NOTE The ISP or network must use a POP3 or IMAP4 e-mail server
and an SMTP gateway.

You can use multiple e-mail services to receive your messages. For each
e-mail service you intend to use, first set up and name the e-mail service.
If you use the same service to connect to different mailboxes, set up and
name each mailbox connection.

To set up an e-mail service:

• In Inbox on your device, tap Services, then New Service. Follow the
instructions on the New Service wizard.

For an explanation of a screen, tap  , then tap Help. When done, to
connect to your e-mail server, tap Services then tap Connect. For more
information on using the Inbox program, see “Inbox:  Sending and
receiving e-mail messages” in Chapter 4.

Get help on connecting
See the following locations for more information:

• “Inbox:  Sending and receiving e-mail messages” in Chapter 4.

• Online Help on the device. Tap  , then tap Help. Tap View, All Installed
Help, then tap Inbox or Connections.

• ActiveSync Help on the desktop computer. In ActiveSync, click Microsoft
ActiveSynch Help on the Help menu.

• For troubleshooting information, see the Pocket PC Web site at:

http://www.microsoft.com/mobile/pocketpc
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Federal Communications Commission Statement

This device complies with FCC Rules Part 15. Operation is subject to the following two
conditions:

• This device may not cause harmful interference, and

• This device must accept any interference received including interference that may cause
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance with
manufacturer’s instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

• Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital
apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

This class B digital apparatus complies with Canadian ICES-003.

WARNING!  The use of shielded cables for connection of the monitor to
the graphics card is required to assure compliance with FCC
regulations. Changes or modifications to this unit not
expressly approved by the party responsible for compliance
could void the user’s authority to operate this equipment.
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UL Safety Notices
Required for UL 1459 covering telecommunications (telephone) equipment intended to be
electrically connected to a telecommunication network that has an operating voltage to ground that
does not exceed 200V peak, 300V peak-to-peak, and 105V rms, and installed or used in
accordance with the National Electrical Code (NFPA 70).

When using the Pocket PC, basic safety precautions should always be followed to reduce the risk
of fire, electric shock, and injury to persons, including the following:

• Do not use the Pocket PC near water, for example, near a bath tub, wash bowl, kitchen sink
or laundry tub, in a wet basement or near a swimming pool.

• Do not use the Pocket PC during an electrical storm. There may be a remote risk of electric
shock from lightning.

• Do not use the Pocket PC in the vicinity of a gas leak.

Required for UL 1642 covering primary (nonrechargeable) and secondary (rechargeable) lithium
batteries for use as power sources in products. These batteries contain metallic lithium, or a lithium
alloy, or a lithium ion, and may consist of a single electrochemical cell or two or more cells
connected in series, parallel, or both, that convert chemical energy into electrical energy by an
irreversible or reversible chemical reaction.

• Do not dispose the Pocket PC battery pack in a fire, as they may explode. Check with local
codes for possible special disposal instructions to reduce the risk of injury to persons due to fire
or explosion.

• Do not use power adapters or batteries from other devices to reduce the risk of injury to
persons due to fire or explosion. Use only UL certified power adapters or batteries supplied by
the manufacturer or authorized retailers.

Replaceable batteries
If an equipment is provided with a replaceable batterym and if replacement by an incorrect type
could result in an explosion (e.g. with some lithium batteries), the following applies:

– if the battery is placed in an OPERATOR ACCESS AREA, there shall be a marking close
to the battery or a statement in both the operating and the servicing instructions;

– if the battery is placed elsewhere in the equipmen, there shall be a marking close to the
battery or a statement in the servicing instructions.

The marking or statement shall include the following or similar text:
CAUTION

RISK OF EXPLOSION IF BATTERY IS REPLACED
BY AN INCORRECT TYPE.

DISPOSE OF USED BATTERIES ACCORDING
THE INSTRUCTIONS

Compliance is checked by inspection.

Operator access with a tool
If a TOOL is necessary to gain access to an OPERATOR ACCESS AREA, either all other
compartments within that area containing a hazard shall be inaccessible to the OPERATOR by the
use of the same TOOL, or such compartments shall be marked to discourage OPERATOR access.

An acceptable marking for an electric shock hazard is        (ISO 3864, No. 5036)

Equipment for restricted access locations
For equipment intended only for installation in a RESTRICTED ACCESS LOCATION, the
instalation instructions shall contain a statement to this effect.
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